Acknowledgments

Perspection, Inc.

Adobe Dreamweaver CS6 on Demand has been created by the professional trainers and writers at Perspection, Inc. to the standards you’ve come to expect from Que publishing. Together, we are pleased to present this training book.

Perspection, Inc. is a software training company committed to providing information and training to help people use software more effectively in order to communicate, make decisions, and solve problems. Perspection writes and produces software training books, and develops multimedia and Web-based training. Since 1991, we have written more than 120 computer books, with several bestsellers to our credit, and sold over 5 million books.

This book incorporates Perspection’s training expertise to ensure that you’ll receive the maximum return on your time. You’ll focus on the tasks and skills that increase productivity while working at your own pace and convenience.

We invite you to visit the Perspection web site at:

www.perspection.com

Acknowledgments

The task of creating any book requires the talents of many hard-working people pulling together to meet impossible deadlines and untold stresses. We’d like to thank the outstanding team responsible for making this book possible: the writer, Steve Johnson; the editor, Adrian Hyde; the production editor, James Teyler; proofreader, Beth Teyler; and the indexer, Katherine Stimson.

At Que publishing, we’d like to thank Greg Wiegand and Laura Norman for the opportunity to undertake this project, Cindy Teeters for administrative support, and Sandra Schroeder for your production expertise and support.

Perspection
About the Author

Steve Johnson has written more than 70 books on a variety of computer software, including Adobe Photoshop CS5, Adobe Dreamweaver CS5, Adobe InDesign CS5, Adobe Illustrator CS5, Adobe Flash Professional CS5, Microsoft Windows 7, Microsoft Office 2010 and 2007, Microsoft Office 2008 for the Macintosh, and Apple Mac OS X Lion. In 1991, after working for Apple Computer and Microsoft, Steve founded Perspection, Inc., which writes and produces software training. When he is not staying up late writing, he enjoys coaching baseball, playing golf, gardening, and spending time with his wife, Holly, and three children, JP, Brett, and Hannah. Steve and his family live in Northern California, but can also be found visiting family all over the western United States.
We Want to Hear from You!

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what we’re doing right, what we could do better, what areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass our way.

As an associate publisher for Que, I welcome your comments. You can email or write me directly to let me know what you did or didn’t like about this book—as well as what we can do to make our books better.

Please note that I cannot help you with technical problems related to the topic of this book. We do have a User Services group, however, where I will forward specific technical questions related to the book.

When you write, please be sure to include this book’s title and author as well as your name, email address, and phone number. I will carefully review your comments and share them with the author and editors who worked on the book.

Email: feedback@quepublishing.com

Mail: Greg Wiegand
Que Publishing
800 East 96th Street
Indianapolis, IN 46240 USA

For more information about this book or another Que title, visit our Web site at www.quepublishing.com. Type the ISBN (excluding hyphens) or the title of a book in the Search field to find the page you’re looking for.
This page intentionally left blank
# Contents

**Introduction**

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing and Planning a Web Site</td>
<td>1</td>
</tr>
<tr>
<td>Getting Started with Dreamweaver CS6</td>
<td>11</td>
</tr>
</tbody>
</table>

## 1 Preparing and Planning a Web Site

- Beginning with a Plan
- Creating a Visual Mind Map
- Generating a Timeline
- Creating a Storyboard
- Creating a Site Design
- Assembling the Site
- Creating a Site Local Root Folder

## 2 Getting Started with Dreamweaver CS6

- Understanding System Requirements
- Installing Dreamweaver
- Getting Started
- Examining the Dreamweaver Window
- Creating a Web Site
- Opening a Web Site
- Creating a Blank Web Page
- Creating a Web Page from a Blank Template
- Creating a Web Page from a Fluid Grid Layout
- Creating a Web Page from a Template
- Creating a Web Page from a Sample
- Saving a Web Page
- Opening an Existing Web Page or File
- Working with Views
- Switching Between Pages and Views
- Previewing Pages in Live View
- Previewing Pages in Multiscreen View
- Previewing Pages in a Browser
- Getting Help While You Work
Getting Dreamweaver Updates on the Web 40
Closing a Web Page or File 41
Finishing Up 42

3 Working Within the Dreamweaver Environment 43
  Working with Toolbars 44 New!
  Resizing Panels 45
  Working with Panels 46
  Docking and Undocking Panels 48
  Grouping and Ungrouping Panels 49
  Creating a Workspace 50 New!
  Using the Status Bar 52 New!
  Changing the View with the Zoom Tool 54 New
  Working with Rulers 55
  Working with the Grid and Guides 56
  Creating Keyboard Shortcuts 58
  Setting General Preferences 60
  Setting New Document Preferences 62
  Working with Colors 64
  Setting Highlighting Color Preferences 66

4 Managing Web Site Files 67
  Exploring Web Site Files and Folders 68
  Setting Up Site Folders 69
  Viewing the Files Panel 70
  Opening and Creating Files in the Files Panel 72
  Managing Files and Folders in the Files Panel 74
  Finding Files in the Files Panel 76
  Saving a File with Different Formats 78
  Identifying Dreamweaver File Formats 79
  Setting the Home Page 80
  Preparing to Set Page Properties 81
  Setting Appearance Page Properties 82
  Setting Link Page Properties 83
  Setting Heading Page Properties 84
  Changing Title and Encoding Page Properties 85
  Changing Page Properties for a Tracing Image 86
  Using Visual Aids 87 New!
  Working with Invisible Elements 88
  Selecting Elements 90
5 Working with Web Page Text

- Adding Text to Web Pages 92
- Importing Tabular Data 93
- Importing Content from Microsoft Documents 94
- Inserting Special Characters and the Date 96
- Selecting Text 98
- Copying and Pasting Text 100
- Setting Copy/Paste Preferences 102
- Formatting Paragraph Text 103
- Formatting Characters 104
- Using Web Fonts 106
- Modifying Font Combinations 108
- Setting Font Preferences 109
- Controlling Line Spacing 110
- Inserting Horizontal Rules 111
- Creating Ordered and Unordered Lists 112
- Creating Definition Lists 114
- Modifying Lists 115
- Applying Text Styles 116
- Creating Text Styles 118
- Renaming Styles 120
- Finding Text 121
- Finding and Replacing Text or Code 122
- Using the Results Panel 124
- Defining Acronyms and Abbreviations 125
- Checking Spelling 126
- Using Undo and Redo 128

6 Working with Web Page Images

- Using Web Friendly Graphics 132
- Defining an Image Folder 134
- Inserting Images 136
- Inserting Images from Photoshop 138
- Updating Images from Photoshop 140
- Inserting Images from Fireworks 142
- Optimizing Images Using Fireworks 144
- Using an External Editor 145
- Setting File Types/Editors Preferences 146
- Optimizing Image 148
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Images</td>
<td>150</td>
</tr>
<tr>
<td>Using Low Source Images</td>
<td>151</td>
</tr>
<tr>
<td>Resizing Images</td>
<td>152</td>
</tr>
<tr>
<td>Cropping Images</td>
<td>153</td>
</tr>
<tr>
<td>Changing Image Brightness and Contrast</td>
<td>154</td>
</tr>
<tr>
<td>Changing Image Sharpness</td>
<td>155</td>
</tr>
<tr>
<td>Creating Rollover Images</td>
<td>156</td>
</tr>
<tr>
<td>Inserting an Image Placeholder</td>
<td>158</td>
</tr>
<tr>
<td><strong>7 Linking Web Pages</strong></td>
<td>161</td>
</tr>
<tr>
<td>Understanding Link Types</td>
<td>162</td>
</tr>
<tr>
<td>Understanding Paths</td>
<td>163</td>
</tr>
<tr>
<td>Setting the Relative Path</td>
<td>164</td>
</tr>
<tr>
<td>Adding a Link</td>
<td>166</td>
</tr>
<tr>
<td>Adding an Email Link</td>
<td>168</td>
</tr>
<tr>
<td>Linking within a Web Page</td>
<td>170</td>
</tr>
<tr>
<td>Creating Image Map Hotspots</td>
<td>172</td>
</tr>
<tr>
<td>Modifying Image Map Hotspots</td>
<td>174</td>
</tr>
<tr>
<td>Creating a Null or Script Link</td>
<td>175</td>
</tr>
<tr>
<td>Modifying a Link</td>
<td>176</td>
</tr>
<tr>
<td>Removing a Link</td>
<td>177</td>
</tr>
<tr>
<td>Updating Links</td>
<td>178</td>
</tr>
<tr>
<td>Testing a Link</td>
<td>180</td>
</tr>
<tr>
<td>Changing Links Sitewide</td>
<td>182</td>
</tr>
<tr>
<td><strong>8 Working with Web Page Tables</strong></td>
<td>183</td>
</tr>
<tr>
<td>Working with Tables</td>
<td>184</td>
</tr>
<tr>
<td>Switching Between Table Modes</td>
<td>185</td>
</tr>
<tr>
<td>Inserting a Table in Standard Mode</td>
<td>186</td>
</tr>
<tr>
<td>Modifying a Table</td>
<td>188</td>
</tr>
<tr>
<td>Adding Content into a Table</td>
<td>190</td>
</tr>
<tr>
<td>Importing and Exporting Table Data</td>
<td>192</td>
</tr>
<tr>
<td>Adding Columns or Rows to Tables</td>
<td>194</td>
</tr>
<tr>
<td>Resizing Columns and Rows</td>
<td>195</td>
</tr>
<tr>
<td>Splitting and Merging Cells</td>
<td>196</td>
</tr>
<tr>
<td>Sorting Table Data</td>
<td>197</td>
</tr>
<tr>
<td>Changing Table Properties</td>
<td>198</td>
</tr>
<tr>
<td>Changing Cell, Row, or Column Properties</td>
<td>200</td>
</tr>
<tr>
<td>Using a Tracing Image</td>
<td>202</td>
</tr>
<tr>
<td>Creating a Nested Table</td>
<td>204</td>
</tr>
</tbody>
</table>
9 Working with Cascading Style Sheets

- Introducing Cascading Style Sheets
- Creating a Web Page with a CSS Layout
- Creating CSS Styles
- Applying Internal CSS Styles
- Applying and Modifying External CSS Styles
- Applying Multiple CSS Classes
- Removing Internal Styles
- Using the CSS Styles Panel
- Editing CSS in the Properties Panel
- Setting CSS Properties
- Working with CSS Rules
- Moving CSS Rules
- Disabling or Enabling CSS Rules
- Inspecting CSS Code
- Creating CSS Transitions
- Viewing Relevant CSS Rules
- Working with ID Selectors
- Creating and Applying an ID Selector
- Checking for CSS Browser Compatibility
- Formatting CSS Code
- Setting CSS Styles Preferences
- Using Design-Time Style Sheets
- Optimizing Web Pages

10 Creating Page Layouts Using CSS-P

- Introducing CSS Layouts and AP Elements
- Creating AP Elements
- Nesting AP Elements
- Setting AP Element Preferences
- Using CSS Positioning
- Applying a CSS-P Style
- Modifying CSS-P Properties
- Working with AP Elements
- Creating a Rollover Using AP Elements
- Converting AP Elements to Tables

11 Creating Page Layouts Using Fluid Grids

- Creating a Fluid Grid Layout
- Viewing a Fluid Grid Layout
# Working with a Fluid Grid Layout
- Resizing a Fluid Grid Layout  
- Modifying a Fluid Grid Layout  
- Previewing a Fluid Grid Layout in a Browser

## Creating Frames
- Creating a New Frame  
- Opening a Web Page in a Frame  
- Providing Information for No Frame Support  
- Selecting Frames and Framesets  
- Adding Frameset Information  
- Saving a Frameset  
- Modifying Frames  
- Changing Frame Properties  
- Changing Frameset Properties  
- Targeting Links  
- Creating Quick and Easy Frame Links

## Working with Multimedia
- Introducing Flash File Types  
- Inserting a Flash or Shockwave Movie  
- Changing Flash or Shockwave Movie Properties  
- Inserting a Flash Video  
- Linking or Embedding Sound  
- Using Java Applets  
- Using ActiveX Controls  
- Using Plug-ins  
- Checking for Plug-ins

## Creating Forms
- Understanding Forms  
- Creating a Form  
- Inserting Form Objects  
- Modifying Text Fields and Text Areas  
- Modifying Radio Buttons and Check Boxes  
- Modifying Lists and Menus  
- Modifying Buttons  
- Inserting an Image Button  
- Making Form Objects Dynamic  
- Using Tables to Control Forms
Validating Forms 324
Creating and Editing a Jump Menu 326
Viewing Example Code for Forms 328

15 Viewing the HTML Behind the Page 329
  Understanding HTML 330
  Using the Reference Panel 332
  Using Code View 334
  Using Code Live View 336
  Setting Code View Options 337
  Entering HTML Code 338
  Using Code Hints 339
  Working with HTML Head Tags 340
  Inserting HTML Comments 341
  Using the Coding Toolbar 342
  Using Quick Tag Editor 344
  Using the Tag Inspector 346
  Using the Tag Chooser 347
  Opening Related Files 348
  Navigating to Related Code 350
  Setting Site Specific Code Hints 351
  Setting Code Hint Preferences 352
  Setting Code Format Preferences 353
  Setting Code Rewriting Preferences 354
  Setting Code Color Preferences 356

16 Working with Behaviors 357
  Introducing Behaviors 358
  Applying Behaviors to Page Elements 360
  Applying Behaviors to Entire Page 362
  Editing Behaviors 364
  Working with Behaviors 366
  Adding Behavior Effects 368
  Going to Another Web Page 370
  Opening Another Browser Window 371
  Displaying Text Messages 372
  Preloading and Swapping Images 374
  Changing Element Properties 376
  Dragging an AP Element 378
  Showing and Hiding Elements 380
Executing a JavaScript 381
Working with Server Behaviors 382

17 Using Spry Widgets and Effects 383
   Inserting Spry Widgets 384
   Selecting and Editing Spry Widgets 386
   Working with Spry Panel Widgets 388
   Working with Spry Validation Widgets 390
   Working with Spry Menu Bar Widgets 392
   Creating a Spry Tooltip 394
   Displaying Spry Data Sets 396
   Creating a Spry Region 400
   Creating a Spry Repeat List 402
   Customizing a Spry Widget 403
   Adding and Removing Spry Effects 404
   Checking Out Spry Samples 406

18 Using Code Snippets and Libraries 407
   Introducing Snippets 408
   Inserting a Snippet 410
   Editing Existing Snippets 412
   Creating Snippets 414
   Introducing Assets and Libraries 416
   Using the Assets Panel 417
   Inserting an Asset 418
   Working with Site Assets 419
   Working with Color and URL Assets 420
   Working with Favorite Assets 422
   Creating and Inserting Library Items 424
   Editing Library Items 426
   Working with Library Items 428
   Creating an External JavaScript Library 430
   Inserting and Editing an External JavaScript 432
   Using Server-Side Includes 434

19 Creating Templates 435
   Introducing Templates 436
   Creating a Template 437
   Opening a Template 438
   Defining Editable Regions 440
   Defining Editable Attributes 441
Creating Repeating Regions 442
Creating Optional Regions 444
Creating InContext Editable Editing Regions 446
Creating InContext Editable Repeating Regions 448
Creating Nested Templates 450
Creating a Web Page from a Nested Template 452
Creating a Web Page from a Custom Template 453
Updating a Template 454
Attaching or Detaching a Template 456
Importing XML into a Template 457
Exporting Template Data as XML 458

20 Testing a Web Site 459
Finding Broken Links 460
Fixing Broken Links 462
Validating Web Pages 464 New5.5
Checking for HTML Browser Compatibility 466
Checking Pages in a Browser 468
Checking for Balanced Code 470
Cleaning Up HTML 472
Cleaning UP Word HTML 474
Adding Accessibility 476
Running Reports to Test a Site 478
Viewing and Saving Reports 480
Gathering Download Statistics 482

21 Managing a Web Site 483
Setting Advanced Site Definitions 484 New!
Defining Local Info for a Site 486 New5.5
Defining Remote Info for a Site 488 New5.5
Defining the Testing Server 492 New5.5
Defining Version Control 493
Defining Site Cloaking 494
Setting File View Columns Options 495
Using Design Notes 496
Viewing Design Notes 498

22 Moving Your Site to the Internet 499
Setting Site File Preferences 500 New!
Managing Site Files with the Files Panel 502
Transferring Files 504
Introduction

Welcome to Adobe Dreamweaver CS6 on Demand, a visual quick reference book that shows you how to work efficiently with Dreamweaver CS6. This book provides complete coverage of basic to advanced Dreamweaver skills.

How This Book Works

You don’t have to read this book in any particular order. We’ve designed the book so that you can jump in, get the information you need, and jump out. However, the book does follow a logical progression from simple tasks to more complex ones. Each task is presented on no more than two facing pages, which lets you focus on a single task without having to turn the page. To find the information that you need, just look up the task in the table of contents or index, and turn to the page listed. Read the task introduction, follow the step-by-step instructions in the left column along with screen illustrations in the right column, and you’re done.

What’s New

If you’re searching for what’s new in Dreamweaver CS6, just look for the icon: New!. For Dreamweaver CS5.5, look for the icon: New5.5. The new icon appears in the table of contents and throughout this book so you can quickly and easily identify a new or improved feature in Dreamweaver CS6. A complete description of each new feature appears in the New Features guide in the back of this book.

Keyboard Shortcuts

Most menu commands have a keyboard equivalent, such as Ctrl+P (Win) or ⌘+P (Mac), as a quicker alternative to using the mouse. A complete list of keyboard shortcuts is available on the web at www.perspection.com.
Step-by-Step Instructions

This book provides concise step-by-step instructions that show you "how" to accomplish a task. Each set of instructions includes illustrations that directly correspond to the easy-to-read steps. Also included in the text are time-savers, tables, and sidebars to help you work more efficiently or to teach you more in-depth information. A “Did You Know?” provides tips and techniques to help you work smarter, while a “See Also” leads you to other parts of the book containing related information about the task.

Real World Examples

This book uses real world example files to give you a context in which to use the task. By using the example files, you won’t waste time looking for or creating sample files. You get a start file and a result file, so you can compare your work. Not every topic needs an example file, such as changing options, so we provide a complete list of the example files used throughout the book. The example files that you need for project tasks along with a complete file list are available on the web at www.perspection.com.
Workshops

This book shows you how to put together the individual step-by-step tasks into in-depth projects with the Workshop. You start each project with a sample file, work through the steps, and then compare your results with a project results file at the end. The Workshop projects and associated files are available on the web at www.perspection.com or at queondemand.com.

Adobe Certification

This book prepares you for the Adobe Certified Expert (ACE) and Adobe Certified Associate (ACA) exams for Adobe Dreamweaver CS6. Each Adobe certification exam has a set of objectives, which are organized into broader skill sets. To prepare for a certification exam, you should review and perform each task identified with an ACE or ACA objective to confirm that you can meet the requirements for the exam. Information about the ACE and ACA programs are available in the back of this book. The ACE and ACA objectives and the specific pages that cover them are available on the web at www.perspection.com or at queondemand.com.
Get More on the Web

In addition to the information in this book, you can also get more information on the web to help you get up to speed faster with Dreamweaver CS6. Some of the information includes:

**Transition Helpers**
- **Only New Features.** Download and print the new feature tasks as a quick and easy guide.

**Productivity Tools**
- **Keyboard Shortcuts.** Download a list of keyboard shortcuts to learn faster ways to get the job done.

**More Content**
- **Photographs.** Download photographs and other graphics to use in your Dreamweaver documents.
- **More Content.** Download new content developed after publication.

You can access these additional resources on the web at www.perspection.com.
Creating Forms

Introduction

Forms are all around us... You fill out forms to get your driver's license, apply for a job; even to get married. A simple definition of a form would be some method for extracting information on a particular subject. For example, to fill out a job application form, you would have to enter your pertinent information on who you are (name, address), recent jobs, why you're experienced enough to apply for the job, and government stuff, like your social security number. An even simpler definition would be to say that forms collect information... it's how you collect that information that makes all the difference.

For example, you might design your form on paper, and the person filling out the form is required to write the information down with a pen or pencil. The information is collected by another person, and along with other forms, compiled (by hand) into a final readable product. Not very efficient; however, that's the way it was done, many long years ago.

Today forms are filled out on a computer screen; the data is validated and compiled into a readable final product, along with relevant statistics and averages. What I'm describing is creating electronic forms, designed, implemented, and finished, all with the help of Adobe Dreamweaver.

Adobe Dreamweaver simplifies the process of creating and implementing forms of any size and complexity. In this chapter you learn how to create basic forms, and populate the forms with all the goodies, such as: check boxes, radio buttons, text input fields; even drop-down menus.

Once a form is created, it can deposit that information into an appended database, where other statistical applications can massage the data into any structure desired by the final user.
As mentioned in the previous section, forms are all about the collection and eventual processing of information. Considering the information-based society that we live and work in, without forms the entire world would probably fall apart in a matter of days. Well, maybe that’s a bit exaggerated; however, forms collect information, information drives our lives, and Dreamweaver makes the creation of those forms a virtual snap.

Beyond Dreamweaver

It’s important to understand that although Dreamweaver will make the overall creation of a form easy (buttons, check boxes, input fields, etc), it does not include the backend tools that make the form functional. For that you will need to install a form handler on your server. In many cases someone in the IT department performs this function. Understand that until the form handler is installed, your visitors will not be able to send you any data; no matter how many times they click the Submit button.

While the scope of the book is not to teach you how to write form handler code, there are many sites that offer free form-handler scripts. These sites typically provide scripts for collecting simple and predictable form data; for more complex scripts the services of an engineer might be required.

Form Elements

Forms can be populated with any number of elements. For example, you could create a simple bio form that asks for information such as name, address, phone number, sex, age, social security number, etc. Because of all this information, it’s a good idea to sketch out the general look and feel of the form on a piece of paper, and then use that as a visual guide to the creation of the form in Dreamweaver. When you create an interactive field, Dreamweaver inserts the code necessary to display the field in the browser.

Dynamic Form Elements

A dynamic form element is a form object that gets its initial value by the web server where the web site is stored. When a visitor opens a form page in a browser, the dynamic form objects get information directly from the web server before the page appears on the screen. When form objects are dynamic, it makes updating a snap. In order to use dynamic form objects, you need to have a data source set up and available on your web server.

Form Validation

Once the various form elements are ironed out, you can look at the possibility of validating some of the fields. For example, it might be difficult to create a validation for a name field; however, you at least check to see that the field is not blank. In addition, you could check to see if all zip code fields contain five numbers and not alphabetic characters. Options that require specific answers, such as sex (male/female) could be placed as a pop-up with the correct choices, and other options could be designed using check boxes or radio buttons. In most cases, using check boxes allows the user to choose more than one option (check all that apply), and radio button typically allow for a single choice from a group (choose only one). When you choose form validation, Dreamweaver creates a script that instructs the browser how to handle the input.
Chapter 14 Creating Forms

Forms tab with form related buttons

Form elements
Creating a Form

Create a Form

1. Create a new HTML document, or open an existing one.
2. Click to place the insertion point where you want to insert a form.
3. Insert the form using one of the following options:
   - Click the Forms tab on the Insert panel, and then click the Form button.
   - Click the Insert menu, point to Form, and then click Form.

An empty form appears with a dotted red outline.

**TROUBLE? If you don’t see the outline, click the View menu, point to Visual Aids, and then click Invisible Elements.**

4. Open the Properties panel.
5. Click the red form outline to select the form.
6. Type a name to identify the form for reference purposes with a scripting language.

Just because Dreamweaver makes the initial creation of the form easy for you, it doesn’t mean that you shouldn’t think about its construction. One of the rules in creating forms is that you’re designing the form for the person who is filling it out… not for you. The form should be as simplistic as possible with easy to understand instructions. When they make a mistake (not filling in a field), there should be a way to tell that person a mistake was made, and what to do to correct it. Studies show that the more difficult the form, the less likely that people are going to spend the time to fill it out. There are two stages in the creation of a form: The initial insertion of the form, and then populating the form with text and form objects.
Chapter 14 Creating Forms

Enter the path to the page or script that processes the form data, or click the Browse For File button to select a file (if you don’t have this information, you can add it later).

Click the Method list arrow, and then select one of the following options:

◆ Default. Uses the browser’s default setting to send the form data to the server. Typically the default is the GET method.

◆ GET. Appends the value to the URL requesting the page.

◆ POST. Embeds the form data in the HTTP request.

Insert the form objects you want and specify the information in the Input Tag Accessibility Attributes dialog box. When you create form objects, follow these guidelines:

◆ Unique Names. Use a unique name that identifies the object for scripting purposes. Avoid using spaces or special characters.

◆ Layout. Use line and paragraph breaks, formatted text, and tables to design the form layout.

See Also

See “Inserting Form Objects” on page 314 for information on inserting form objects.

For Your Information

Starting a Form from a Sample

Instead of creating a form from scratch, you can start a form from a sample, and then make the changes you want to suit your own needs. Click the File menu, click New, click the Page From Sample category, click Starter Page (Basic), click the sample page you want, such as Survey, Multiple Choice or Register (Basic), and then click Create.
Inserting Form Objects

Insert Form Objects

1. Open a page that contains a form, or create a new document and insert a form.

2. Click to place the insertion point to where you want to insert a form object.

3. Click the Forms tab on the Insert panel, or click the Insert menu, point to Form, and then select from the following commonly used form objects:

   ◆ Text Field. Select to create a text field that consists of one line or multiple lines. In addition, text fields are used to create a password field that hides the text the user enters.

   ◆ Text Area. Select to create a large text area that is commonly used by a visitor to enter large amounts of data; for example, a comment field.

   ◆ Button. Select to create a button object. Buttons are used to submit form data to the server or to reset the form. Standard form buttons are typically labeled Submit, Reset, or Send. You can also assign other processing tasks that you’ve defined in a script.

After you create a form, you can starting inserting form objects. Form objects are the individual elements—such as text field, text area, button, check box, radio button, or menu—that make up the form and visitors fill out. The form objects allow you to create a form that makes it easy for visitors to use, yet still provide you with the important information you need. Each form object is designed to gather a specific type of information. For example, if you have a list of categories and you can select more than one category, you should use the check box form object. If you can only select one category, you should use the radio button form object instead.
- **Checkbox.** Select to let users select more than one option from a set of options.

- **Radio Button.** Select to let users select only one choice from a set of options. Radio buttons are typically used in groups.

- **List/Menu.** Select to let users select one or more items from a list.

In the Input Tag Accessibility Attributes dialog box, specify the following options:

- **ID.** Enter a unique ID for the form object.

- **Label.** Enter a label for the form object.

- **Style.** Select a style for the form object.

- **Position.** Select a position for the label in relation to the form object.

- **Access Key.** Enter a keyboard equivalent (single letter) in the Access Key text box. For example, if you entered the letter N into the field, pressing Alt+N (Win) or Control+N (Mac) in the browser automatically selects that field.

- **Tab Index.** Enter a numerical value for the tab order of the form object in the Tab Index text box. For example, if you entered the number 3 into the field, pressing the tab key three times would cause the field to be selected.

5 Click **OK.**
Modifying Text Fields and Text Areas

Work with Text Field and Text Area Properties

1. Select a text input field or text area within a form document.
2. Open the Properties panel.
3. Select from the following text field or text area options:
   - **Char Width.** Enter the maximum number of characters that can be displayed in the field.
   - **Max Chars.** Enter the maximum number of characters that can be entered in the field for single-line text fields.
   - **Num Lines.** Enter the height of the field for multiple-line text fields.
   - **Wrap.** Determines how the user’s input will be displayed when the user enters more information than can be displayed within the defined text area.
     - **Off.** Prevents text from wrapping to the next line.
     - **Virtual.** Sets word wrap in the text area.
     - **Physical.** Sets word wrap in the text area, as well as to the data when it is submitted for processing.

A text field consists of one line or multiple lines used to enter small distinct amounts of data or information, such as your name or address. You can also use a text field to create a password field that hides the text the user enters. A text area is a large text field commonly used to enter large amounts of data or information, such as comments. After you create a text field or text area, you can use the Properties panel to set or change options for the form objects.
◆ **Type.** Designates the field as a single-line, multiple-line, or password field.

◆ **Single-line.** Selecting to cause the Char Width and Max Chars settings to map to a single line with defined boundaries.

◆ **Password.** Select to create a password field (information typed into the field appears as asterisks or dots).

◆ **Multi-line.** Select to create a multi-line field.

**NOTE** The default for text area fields is multi-line.

◆ **Init Value.** Enter an initial value that displays when the field first loads.

◆ **Class.** Click to apply CSS rules to the object directly or through a CSS Style sheet.
Modifying Radio Buttons and Check Boxes

Work with Radio Button and Checkbox Properties

1. Select a radio button or checkbox within a form document.
2. Open the Properties panel.
3. Select from the following radio button options:
   - **Radio Button/Checkbox.** Enter a name for the Radio Button or Checkbox object.
     
     **NOTE** If the name of a group of radio buttons is the same, then the user will only be able to select one button (i.e. male or female). The name cannot contain spaces or special characters.
   
   **NOTE** Unlike radio buttons, every checkbox must have a unique name.
   
   - **Checked Value.** Enter in a value to be sent to the server when the button is selected. For example, male or female.
   
   - **Initial State.** Select whether to have the button selected or not when the form first loads.
   
   - **Class.** Click to apply CSS rules to the object directly or through a CSS Style Sheet.

Radio buttons and check boxes allow you to create options for users to select. A radio button allows a user to select only one choice from a set of options, while a check box allows a user to select more than one option from a set of options. Radio buttons are typically used in groups. Both form objects are very often used when you want to create a survey. After you create a radio button or check box, you can use the Properties panel to set or change options for the form objects.
Modifying Lists and Menus

Work with List/Menu Properties

1. Select a list/menu field within a form document.
2. Open the Properties panel.
3. Select from the following list/menu options:

   - **List/Menu.** Enter a unique name for the menu.
   - **Menu.** Select to have the menu drop down when clicked.
   - **List.** Select to display a scrollable list of items when clicked.
   - **Height.** Enter a value to determine the number of items displayed in the menu (List type only).
   - **Selections.** Select to allow the user to select multiple items from the list (List type only).
   - **List Values.** Click to add items to the menu.
   - **Class.** Click to apply CSS rules to the object directly or through a CSS Style Sheet.
   - **Initially Selected.** Select from the available items to make the item initially selected when the browser loads the form.

Lists and menus perform similar tasks; each allows you to select an item from a list of related items. However, there are some differences. A list allows you to scroll through the items as well as select multiple items, while a menu doesn’t. When you select an item from a list or menu, you can execute an action using a script or behavior. After you create a list or menu, you can use the Properties panel to set or change options for the form objects.
Modifying Buttons

Work with Button Properties

1. Select a button field within a form document.
2. Open the Properties panel.
3. Select from the following button options:
   - **Label.** Use to add a label next to a text field, check box, or radio button option. Click next to the object, and then type the label.
   - **Value.** Enter the name of the button (appears directly on the button).
   - **Action.** Determines what happens when the button is clicked.
     - **Submit Form.** Select to submit the form data for processing when the button is clicked.
     - **Reset Form.** Select to clear the contents of the form when the button is clicked.
     - **None.** Select if you want to add a JavaScript behavior for the button.
   - **Class.** Click to apply CSS rules to the object directly or through a CSS Style Sheet.

Buttons are used to execute an action. Form buttons are generally used to submit form data to the server or to reset the form. Standard form buttons are typically labeled Submit, Reset, or Send. In addition to the standard form buttons, you can assign other processing tasks that you’ve defined in a script or behavior to create a custom button. After you create a button, you can use the Properties panel to set or change options for the form objects.
Inserting an Image Button

Insert an Image Button

1. Create a new HTML document, or open an existing page.
2. Click to place the insertion point where you want to insert an image button.
3. Insert the image using one of the following options:
   - Click the Forms tab on the Insert panel, and then click the Image Field button.
   - Click the Insert menu, point to Form, and then click Image Field.
4. Locate and select the image you want to use as a button.
5. Click OK.
6. In the Properties panel, select from the following options:
   - Image Field. Enter a unique name for the image.
   - Src. Enter the path and name for the image or click the Browse For File button to select the image file.
   - Alt. Enter a description of the image.
   - Align. Click to select an alignment option.
   - Edit Image. Click to edit the image in your default editor.
   - Class. Click to apply CSS rules to the object directly or through a CSS Style Sheet.

Instead of using one of the built-in buttons provided by Dreamweaver, you can insert an image and use it as a button. This allows you to create a custom look for your form, yet still provide the functionality you want. After you insert an Image button, you can use the Properties panel to set or change options for the form object.
Making Form Objects Dynamic

Instead of setting static form options in Dreamweaver, you can set form options dynamically (on the fly) from your web server, known as a dynamic form object. For example, you can dynamically set a form menu or list menu with entries from a database, display content in text fields when viewed in a browser, or preset a radio button or check box when viewed in a browser.

When a page with a dynamic form object is displayed from a web server, the initial state is determined by the server. Making form objects dynamic makes updating and maintaining a web site much easier. Instead of manually changing a menu item, you can simply change an entry in a database table where the information is stored.

In order to use dynamic form objects, you need to have a data source set up, such as a MySQL database, and available on your web server. The set up and connection of a data source is outside the scope of this book, so you should see your ISP or web administrator for more details.

Make Form Objects Dynamic

1. Select the form object you want to make dynamic within a form document.
2. Open the Properties panel.
3. Click the Dynamic button or click the Lighting Bolt icon.
4. Select the options you want to make the form object dynamic; the options vary depending on the form object.
   - Select an existing data source, or click the Plus (+) button to define a new data source.
5. Click OK.
Using Tables to Control Forms

When you create a table, it’s a simple matter to add form elements on a line-by-line basis. However, in many cases this simplistic method may not suit your particular form layout. In that case, it’s tables to the rescue. A smart form designer can use a table within the form (just like in standard design), to control the look and positioning of all the form elements. Once the table is inserted into the form, it’s a simple matter to use the individual table cells to insert the various elements (for more information on the creation of a table, turn to Chapter 8). The only requirement for the table is that it must be placed within the red dotted lines defining the form.

Control the Form with Tables

1. Create a new document or open an existing page.
2. Click to place the insertion point to where you want to insert a form.
3. Insert the form using one of the following options:
   - Click the Forms tab on the Insert panel, and then click the Form button.
   - Click the Insert menu, point to Form, and then click Form.

   An empty form appears with a dotted red outline.

4. Select the form.
5. Click the Insert menu, click Table, select the table options that you want, and then click OK.
6. Click into an individual cell.
7. Click the Forms tab on the Insert panel, or click the Insert menu, point to Form, and then select from the available form objects.

   The table cells control the placement and design of the form.
Validating Forms

Validate HTML Form Data

1. Open a form document, or create a new form document.

**IMPORTANT** The form document must contain at least one text field and a Submit button. In addition, all text fields must have unique names.

2. Select the Submit button inside the form that you want to validate.

3. Click the Window menu, and then click Behaviors to display the Behaviors panel.

4. Click the Add Behavior button (the Plus (+) sign), and then click Validate Form.

5. Select the form input fields one at a time, and then validate the form using the following options:
   - **Required.** Select to make the form object required.
   - **Anything.** Accepts any input entered by the user.
   - **Number.** Restricts input to numeric.
   - **Email address.** Looks for an e-mail address with the @ sign.
   - **Number from.** Enables you to enter a minimum and maximum range for numeric values.

The Validate Form action checks the contents of specified text fields to ensure that the user has entered the correct type of data. You can attach this action to individual text fields using an onBlur event to validate the fields as the user is filling out the form, or attach it to the form with the onClick event to evaluate several text fields at once when the user clicks the Submit button. Attaching this action to a form prevents the form from being submitted to the server if any of the specified text fields contains invalid data. In addition, Dreamweaver can add JavaScript code that checks the contents of specified text fields to ensure that the user has entered the correct type of data.
6 Click **OK** to add the validation information (in script) to the HTML form document.

7 Click the **Action** button in the Behaviors panel, and then select one of the following options:
   - **OnClick.** Select if you are validating multiple fields when the user submits the form.
   - **OnBlur.** Select if you are validating individual fields.

8 Click the **File** menu, point to **Preview In Browser**, and then check the current validation actions.
Creating and Editing a Jump Menu

Create a Jump Menu

1. Create a new web page or Open the web page where you want to insert a jump menu.
2. Click to place the insertion point to where you want to insert a jump menu.

**NOTE** Dreamweaver inserts a form at the insertion point (if you haven’t already created one).
3. Click the *Forms* tab on the Insert panel, or click the *Insert* menu, point to *Forms*, and then click *Jump Menu*.
4. Create the jump menu using the following options:
   - **Menu Items.** Click the Plus (+) sign to add more “unnamed” menu items to the list. Click the Minus (-) sign to remove “unnamed” items from the list. Use the up and down arrows buttons to move selected items within the list.
   - **Text.** Select an “unnamed” menu item in the Menu Items box, and then enter a name in the text field. Continue selecting “unnamed” items until all have been properly named.

Most web sites employ buttons to help the visitor navigate through the various pages; however, it’s possible to create a jump menu, using a simple form element. A jump menu utilizes a form object to create a list of menu options. When the visitor clicks on the list, a drop-down menu displays a listing of all the available page options. Displaying a listing of all available page options within a single drop-down menu is a creative use of form objects that makes navigation through a complex site much easier for your visitors. After you create a jump menu, you can make changes to it as needed. You can add, delete, rename or change the order of items in the menu. In addition, you can modify the file an item links to. If you want to change the location in which a linked file opens, or to add or change a menu selection prompt, you need to apply the Jump Menu behavior from the Behaviors panel.
When Selected, Go To URL. Select a menu item in the Menu Items box, and then enter the path and filename of the page you want opened for the selected item or click Browse to select the file.

Open URLs In. If you’re not working within a frameset, you have only one option: Main Window.

Menu ID. Enter a unique name for the menu in the input field (optional).

Insert Go Button After Menu. Select to add a button that activates the jump menu.

Select First Item After URL Change. Select to reset the menu selection to the top item after each jump.

Click OK.

Edit a Jump Menu

1. Open the web page where you want to edit a jump menu.
2. Open the Properties panel.
3. Select a jump menu object.
4. Click the List Values button.
5. Make the changes you want.
6. Click OK.
The <form></form> Tags

The first step in the creation of a form is to place the HTML <form></form> tags on your page. All items defining the form must be placed within those tags.

```html
<html>
<head>
<meta http-equiv="Content-Type" content="text/html; charset=ISO-8859-1" />
<title>Untitled Document</title>
</head>
<body>
<form id="form1" name="form1" method="post" action="">
</form>
</body>
</html>
```

Form Elements

The following is an example of the HTML code necessary to display a text input field for a person's name, address, city, state, and zip code.

```html
<body>
<form id="form1" name="form1" method="post" action="">
  <label>Name
    <input type="text" name="textfield"/>
  </label>
  
  <label>Address
    <input type="text" name="textfield2"/>
  </label>
  
  <label>City
    <input type="text" name="textfield3"/>
  </label>
  
  <label>State
    <input type="text" name="textfield4"/>
  </label>
  
  <label>Zip
    <input type="text" name="textfield5"/>
  </label>
</form>
</body>
```

Form Validation

The following is an example of a form validation script that validates an email address input field:

```javascript
function MM_validateForm() { //v4.0
  var i,p,q,nm,test,num,min,max,errors='',args=MM_validateForm.arguments;
  for (i=0; i<(args.length-2); i+=3) { test=args[i+2];
    val=MM_findObj(args[i]);
    if (val) { nm=val.name; if ((val=val.value)!="") {
      if (test.indexOf('isEmail')!=-1) {
        p=val.indexOf('@');
        if (p<1 || p==(val.length-1)) errors+='- '+nm+'
must contain an e-mail address.\n';
      } else if (test!="R") { num = parseFloat(val);
        if (isNaN(val)) errors+='- '+nm+' must contain a number.\n';
        if (test.indexOf('inRange') != -1) {
          p=test.indexOf(':');
          min=test.substring(8,p); max=test.substring(p+1);
          if (num<min || max<num) errors+='- '+nm+' must contain a number between '+min+' and '+max+'.\n';
        } }
    } else if (test!="R") errors += '- '+nm+' is required.\n';
  }
  if (errors) alert('The following error(s) occurred:
'+errors);
  document.MM_returnValue = (errors == "");
}
```
Index

A
abbreviations, defining, 125
absolute paths, 163
absolute positioning of AP elements, 248
accessibility, 9, 459
  adding accessibility, 477
  preferences, setting, 476
  Section 508, accessibility issue, 9
  Remote Info options, 488-491
access keys
  for form objects, 315
  for links, 167
acronyms, defining, 125
actions. See behaviors; events; snippets
ActionScript files, 79
activating Dreamweaver, 15
active link colors, 83
Active Server Pages (ASP), 68, 79, 382, 492
  showing/hiding tags, 89
Active Server Plus Pages files, 79
ActiveX controls, using, 302-303
Add Behavior button, 361
addpro Web site, 20
Adobe. See also Fireworks, Flash; Illustrator; Photoshop
  activating Dreamweaver, 15
downloading applications, 13
help resources, 39
manuals, 332
Adobe Bridge, 30-31
Adobe BrowserLab, 36-37, 468-469
Adobe ColdFusion. See CFML, ColdFusion
Adobe Contribute, 485
Adobe CSS Advisor Web site, 236
advanced find and replace. See finding/replacing
Advanced Site Setup Web site, 483
  setting site definitions, 484-485
advertising banners, 136
AIF files, linking or embedding, 298
Ajax framework help, 39
alert dialog box, text, displaying, 372
alias of application, creating, 14
alignment. See also tables
  for ActiveX objects, 303
  AP elements, 255
CSS properties, setting, 222
elements
  anchor points, showing/hiding, 89
  AP elements, 255
for Flash/Shockwave movies, 295
forms, image buttons in, 321
with grids and guides, 56
of horizontal rules, 111
images, aligning, 150
for Java applets, 301
option for, 150
of paragraph text, 103
alternate content
  ActiveX objects, images for, 303
  for Java applets, 301
text, using, 477
<alt> tags, 479
anchors. See named anchors
Android
  packaging for, 518-519, 532-533
  SDK, 532-533
Apache server, 68, 382, 434
AP elements
  aligning, 255
  borders, showing/hiding, 246
  changing CSS-P positioning, 248
dragging, 378-379
AP elements (continued)
for image map hotspots, 174
introduction to, 244
manually creating, 245
moving, 255
naming, 250
nesting, 246
outlines, 87
overlapping, preventing, 254
preferences, setting, 247
previewing positioning, 253
properties, modifying, 252-253
resizing, 255
rollovers with, 256-257
Show/Hide Elements action, 358
stacking order, changing, 254-255
styles, creating, 249
tables, converting to, 258-259
working with, 254-255
z-index, applying, 251
APK file format, 532-533
appearance page properties, setting, 82
appear/fade, 368
spry effects, adding, 404
Apple iOS-based device
packaging for, 518-519, 532-533
Application bar, 16, 16-17, 44
application server, 68, 382
Apply Source Formatting option, 353
arrow keys in Code view, 541
ASP file tags, inserting, 347
ASP.NET file tags, inserting, 347
ASPX format, 29
assembling site, 9
assets, 416. See also color assets; libraries; templates; URL assets
favorite assets, working with, 422-423
Favorites folder, grouping assets in, 423
inserting, 418
modifying assets, 419
multiple assets, selecting, 419
previewing, 418
sorting, 422
Assets panel
documents from templates, creating, 24
images, inserting, 136
opening templates from, 438
resizing, 422
working with, 417
attachments. See also templates
external style sheet, attaching, 214
attributes. See also CSS (Cascading Style Sheets)
legal characters in values, 355
audience, 3, 8
demographic studies, 3, 8
audio files, linking or embedding, 298-299
autoplay. See Flash
autostretch. See tables
AVD app information, 532-533
AVI files information, 532-533
B
Background File Activity dialog box, 505
backgrounds. See also CSS (Cascading Style Sheets); Flash; tables
of AP elements, 247
properties, setting, 82
balanced code, checking for, 470-471
bandwidth, 482
base tag, 340
Basic Site Definition Wizard, 483
behaviors, 357-358. See also events
changing event for behavior, 365
deleting, 367
downloading third-party behaviors, 362
editing, 374-365
effects, adding, 368-369
entire page, applying to, 362-363
introduction to, 357-359
multiple behavior order, changing, 366
page elements, applying to, 360-361
parameters, editing, 364
Behaviors panel, 360-361
Benguiat font, 91
Bindings panel, 382
Blackberry
packaging for, 518-519, 532-533
blank Web page, creating, 21
blinds, 368
spry effects, adding, 404
block snippets. See snippets
<body> tag, 362-363
boldfacing
  characters in text, 104
  with Copy and Paste Special, 101
  copying/pasting, setting for, 102
  for headings, 84
  for links, 83
  table text, 191
BOM (Byte Order Mark), selecting, 63
Box model, 253
borders. See also CSS (Cascading Style Sheets); Flash; frames and framesets; tables
  AP element borders,
  showing/hiding, 246
  Change Property behavior for, 376
braces < >, 330
  balance, checking for, 470-471
  Coding toolbar options, 342
brightness of images, 154
broken links, finding and fixing, 460-462
browser compatibility, 466-467
  CSS browser compatibility, checking for, 236-237
  testing, 361
Browser Compatibility Check (BCC), 236-237, 466-467
Browser Navigation, 32-33
  testing link, 180-181
  using, 33
browsers
  Code view
    compatibility, checking for, 466-467
    scripts, inserting browser-safe, 355
  colors, browser-safe, 64
  editing list of, 37
  events, support for, 359
  independence, testing for, 459
  no frame support, information for browser with, 277
  previewing in, 36-37
  relative path for new links, previewing, 164-165
BrowserLab, 36-37, 468-469
<b> tag, 117, 330
buffers for Flash video, 297
Build and test phase, 8
bulleted lists. See ordered/unordered lists
Business Catalyst
download and install, 512
  extension, 512
  panel, 512-513
  work with, site, 513
C
  cache files
    for file/asset information, 487
    for link information, 178-179
  Call JavaScript behavior, 381
captions. See also Flash elements
table captions, entering, 187
cascading, in terms of CSS, 205, 232
  cascading Document window, 41
case sensitivity
    of file names, 27
    finding/replacing with, 123, 547, 549
    of links, 487
    for tag find and replace, 549
    for text find and replace, 547
CDN (Content Delivery Network). See jQuery Mobile
cells. See tables
centering
  AP elements, centering tables with, 258
  paragraph text, 103
  selecting options for, 61
Certificate Authorities, 488-489
CFML files, 29
  help, 39
  tags, inserting, 347
Change Link Sitewide command, 182
Change Property behavior, 376-377
  with text, 371
Change Property Restore behavior, 376
  with text, 371
characters, 355. See also case sensitivity
  CSS character style, applying, 213
  formatting, 104-105
  forms, options for, 316
  other characters, inserting, 96-97
  special characters, inserting, 96
checkboxes. See forms
checking in/checking out site files, 508-509
Check Plug-in behavior, 306-307, 358
  Web page, applying to, 363
class ID for ActiveX objects, 303

cleaning up. See HTML (Hypertext Markup Language)

click and drag for text, 98

client-side image maps. See image maps
cloaking/uncloaking, 484, 516
defining site cloaking, 494
closing
  panels, 46
  Web pages, 41
closing tags, 330
  extra closing tags, deleting, 354
cloud-based service, PhoneGap Build Service, 532-533

CMS, 351

code. See also HTML (Hypertext Markup Language); libraries; snippets
  for Java applets, 301
  for spry effects, 405

Code Coloring, preferences, settings, 356

Code Hints
  popup menu, 338-339
  preferences, 352
  site specific code hints, 351

Code Inspector, 335

Code Navigator, 342-343, 350
coder-oriented workspace (Windows), 335

Code View, 30, 31. See also browsers; Tag inspector

accessing, 334

arrow keys in, 541
assets, dragging, 418
attribute values, legal characters in, 355
balanced tags, checking for, 340
with Code Inspector, 335

Code Navigator, 342-343, 350

Code View Live, 32, 336

Coding toolbar, 44, 342-343

ColdFusion. See also CFML files
  file formats, 79
  help, 39
  introduction, 68, 382
  showing/hiding tags, 89

collapsing. See expanding/collapsing

Color Cubes palette, 64
Color dialog box, 64
color picker, 64-65

colors. See also backgrounds; color assets; Flash; highlighting; tables; text of AP elements, 247
code color highlighting; tables; text of AP elements, 247
code color preference, setting, 356
frame border colors, modifying, 286
for headings, 84
for image placeholders, 158-159
images, optimizing, 148-149
for links, 83
palettes, selecting, 64
table colors, setting, 199
Web-safe colors, 64
working with, 64-65

Color Sliders, 65

Color Wheel button, 64

columns and rows. See also CSS (Cascading Style Sheets); tables
  File View Columns options, 495

colors.

commands, 17
  managing History commands, 543
  recording commands, 544
  running History commands, 542
  saving History panel steps as, 540-541
temporary use, recording/playing commands for, 544
Commands menu, Apply Source Formatting option, 353
comments. See also Code view; HTML (Hypertext Markup Language)
Coding toolbar, removing comments in, 343
showing/hiding, 88
compatibility. See also browser compatibility
AP element compatibility, setting, 247
Contribute feature and, 485
complete storyboards, 7
completion of site, 2-3
Component Inspector panel, 49
connection speed, setting, 53
containers, displaying text in, 372
Continuous Tone palette, 64
contrast of images, 154
Contribute feature, 485
Copy File As dialog box, 137
copying/pasting, 100-101
code, 341
Fireworks images, 142-143
History panel steps between documents, copying, 539
image map hotspots, 174
Photoshop images, 138-139
preferences, setting, 102
snippets, 413
copyrights, 9, 133
cropping images, 153
CSS (Cascading Style Sheets), 29, 67, 205. See also AP elements; forms
advanced styles, 207, 233
attaching external style sheet, 214
attribute style, 206
creating, 210
backgrounds
setting, 222
styles, changing settings for, 252
borders
properties, setting, 223
styles, changing settings for, 253
breakdown of, 206
browser compatibility, checking for, 236, 466-467
character (inline) style, applying, 213
classes, 207
for tables, 199
code formatting preferences, 238-239
Coding toolbar options, 343
colors for ID selector, 234
with Copy and Paste Special, 101
copying/pasting, setting for, 102
creating Web page with CSS layout, 208-209
CSS rules, 212-213
modifying existing rule, 224
moving, 226-227
relevant CSS rules, viewing, 232
custom CSS layouts, 209
default properties, 81
deleting
CSS rule, 225
design-time style sheets, 241
internal style, 218
design-time style sheets, using, 241
disable CSS property, 219, 228
embedded CSS code, formatting, 239
enable CSS property, 219, 228
entire style sheet, modifying, 225
external styles, 207
attaching external style sheet, 214
creating, 211
modifying external style sheet, 215
file formats, 79
fonts
for ID selector, 234
setting, 222
formatting code preferences, setting, 238-239
hidden content, displaying, 89
hover class, 233
HTML (Hypertext Markup Language)
compared, 206
ID selectors
applying, 235
creating, 234
working with, 233
inheritance, 232
Inspect, 229
Multiclass selection, 216-217
paragraph style, applying, 212
CSS (continued)
preferences
  code formatting preferences, setting, 238-239
  styles preferences, setting, 240
Properties panel, 220-221
pseudo-classes, 233
relevant CSS rules, viewing, 232
sample pages with, 25
sample style sheet, using, 215
selecting, 61
selector declaration, 224
  name, changing, 225
shorthand preferences, setting, 240
showing/hiding style sheets, 241
spry widgets, editing, 386
styles
  creating, 210-211
  paragraph style, applying, 212
Styles panel, using, 219
tag style method, 206-207
text style, creating and applying, 118-119
types of styles, 207
visual aids, using, 87
CSS-P (Cascading Style Sheets-Positioning), 247. See also AP elements
applying styles, 250
creating styles, 249
manually changing, 248
properties, modifying, 252-253
CSS Rule Definition dialog box, 222
CSS rules. See CSS (Cascading Style Sheets)
CSS Transitions. See CSS (Cascading Style Sheets)

D
data files for ActiveX objects, 303
Databases panel, 382
dates and times, adding, 97
decorative fonts, 96
Default Color button, 64
default images folder, 487
Define phase, 8
definition lists
creating, 114
modifying, 115
deleting. See also CSS (Cascading Style Sheets); tables; templates
behaviors, 367
closing tags, 354
columns in site, 495
commands, 543
favorites, 422
Flash Video component, 297
font families (combinations), 108
frames, 283
guides, 57
HTML comments, 343
library items, 429
links, 177
menu bar items, 393
properties, 377
remote files, 514
shortcuts/shortcut sets, 58-59
site files or folders, 74
snippets, 413
spry effects, 404-405
demographic studies, 3
description tag, 340
Design document, 8
Design Notes, 484
columns, associating, 495
enabling, 496
erasing, 496
linking with files, 497
viewing, 498
Design phase, 8
design-time style sheets, using, 241
Design view, 30, 31, 334
  assets, dragging, 418
  comments in, 341
  Reference panel, accessing in, 333
  visual aids in, 87
Device Central. See Adobe Device Central
dictionaries, selecting, 61
diff tool, 506-507
digital cameras. See Adobe Bridge
disable/enable CSS, 219, 228
disabled options, 17
discovery sites, 3
dither for images, 148
docking/undocking panels, 48
documents
  History panel steps between documents, copying, 539
  importing/exporting data, 94-95
  links to Microsoft documents, 95
  new document preferences, setting, 62-63
  paths, document-relative, 163
  size, displaying, 52
  from templates, 24
  untitled documents, list of, 479
  viewing multiple documents, 31
Document toolbar, 44
Document window
  cascading and tiling, 41
  examining, 16-17
  resizing, 52
  double-byte inline input, allowing, 61
  double-clicking on text, 98
downloading. See also Flash
  Adobe applications, 13
  behaviors, 362
  estimated download time, displaying, 52
  image download size, displaying, 53
  images affecting time, 151
  snippets, 409
  statistics preferences, 482
  templates, 436
drag-and-drop
  assets, 418
  CSS rules, 227
  external JavaScript library items, 431
Drag AP Element behavior, 378-379
Draw AP Div tool, 245
Dreamweaver API reference, 39
Dreamweaver Exchange Web site, 479
DTD (document type), 62
  selecting, 85
Drupal, 351
dynamic form elements, 310
dynamic images, 136
dynamic pages, 69
dynamic text, showing/hiding, 89
E
editable regions. See templates
editing, 412-413. See also Flash; images
  Browser list, 37
  external JavaScript scripts, 433
  Fireworks images, 143
  jump menus, 327
  library items, 426-427
  Photoshop images, 140-141
  properties, 377
  spry widgets, 386
Edit NoFrames Content command, 277
Edit Snippet button, 412
Edit Tag mode, Quick Tag Editor in, 345
EDML files, 79
effects
  behavior effects, adding, 368-369
  spry effects, adding and removing, 404-405
8-second rule, 151
elastic CSS layout, 208
elements. See also AP elements; assets; behaviors; Flash elements; forms; frames and framesets; invisible elements; Show/Hide Elements behavior; spry widgets
  accessibility, adding, 477
  selecting, 90
email links
  adding, 168
  modifying, 167-168
embedding
  for ActiveX objects, 303
  showing/hiding embedded styles, 88
  sound files, 299
  video files, 299
empty tags, removing, 479
<em> tag
  allowing, 61
  using, 117
enabled options, 17
encoding
  frame encoding, changing, 284
  selecting, 62
  specifying encoding type, 85
errors on previewing Web pages, 36
errors, identifying in Code view, 343
| events. See also specific events  
| associated events, 359  
| changing event for behavior, 365  
| specific browser, showing events for, 361  
| existing Web page, opening, 28  
| exiting Dreamweaver, 42  
| Expanded table mode, 185  
| expander arrow, 46  
| expanding/collapsing  
| Coding toolbar options, 342  
| Files panel, 71  
| panels, 46-47  
| exporting. See importing/exporting  
| extending Dreamweaver, help with, 39  
| extensions. See also Adobe Extension Manager  
| Business Catalyst, 512-513  
| CSS styles, changing settings for, 252  
| selecting, 62  
| external editors. See images  
| external JavaScript libraries  
| creating Javascript files, 430-431  
| dragging JavaScript library items, 431  
| editing scripts, 433  
| inserting, 432  
| external style. See CSS (Cascading Style Sheets)  

| F  
| fade. See appear/fade  
| favorite assets  
| adding or deleting, 422  
| Favorites folder, grouping assets in, 423  
| nicknames, creating, 423  
| file formats  
| different formats, saving files in, 78  
| list of, 79  
| files and folders, 67. See also dependent files; extensions; Files panel; local root folder; remote folders; testing servers  
| closing, 41  
| default images folder, 487  
| deleting, 74  
| Design Notes, linking, 497  
| different formats, saving files in, 78  
| existing file, opening, 28  
| Flash file types, 292  
| HTML files, 330  
| image folder, defining, 134-135  
| levels of folders, displaying, 70  
| local root folders, 486  
| setting up site folders, 69  
| site preferences, setting, 500-501  
| snippet folder, creating, 414  
| SpryAssets folder, 384-385  
| Subversion, using, 510-511  
| templates, storing, 23  
| transferring files to and from remote site, 504-505  
| types of files  
| changing, 67  
| list of, 29  
| updating links when moving files, 60  
| working with, 68  
| Files panel  
| creating files in, 73  
| customizing appearance of, 484  
| in expanded view, 71  
| finding files in, 76-77  
| managing files and folders in, 74-75  
| moving files or folders in, 75  
| new site folder, creating, 75  
| opening files in, 72  
| recently modified files, finding, 77  
| refreshing, 72  
| Subversion, using, 510-511  
| viewing files in, 70  
| working with, 502-503  
| File Synchronization, 514-515  
| File View Columns options, 495  
| filters for CSS properties, 223  
| finding/replacing, 122-123, 535. See also tags  
| advanced find and replace for tags, 548-549  
| for text, 546-547  
| Files panel, files in, 76-77  
| last search, repeating, 547  
| queries, creating and using, 550  
| recently modified files, 77  
| Results panel, using, 124  
| templates, editable regions in, 456 |
Find Next command, 121
Find Selection command, 121
firewalls, 489
    settings for, 500-501
Fireworks, 2.
    copying/pasting images, 142-143
    editing images in, 145
    GIF images with, 132
    optimizing images with, 144
    PNG format, 133
    Script files, 79
fixed CSS layout, 208
fixed fonts, preferences, 109
fixing broken links, 462
Flash, 2.
    autoplay, 297
    backgrounds
        for movies, 295
    borders
        for movies, 295
downloading
    video, 296-297
editing
    files, 294
    Flash Video component, 297
    movies, 294
file types, 292
height
    for movies, 294
    for video settings, 296
inserting movies, 293
names
    for movies, 294
    PNG format, 133
    properties of movie, changing, 294-295
URLs
    for video, 296
    video, inserting, 296-297
    widths in movies/videos, 296
Flash Player code, 297
Flash Video files, 292
flexibility of site, 459
flow chart for site, 6
Fluid Grid Layouts
    creating, 23, 262-263
    deleting elements, 267
    inserting elements, 267
introduction 261-262
moving layouts, 270
preview in a browser, 271
resizing layouts and margins, 268-269
selecting elements, 266
showing/ hiding guides, 87, 265
viewing, 264
FLV format, 296-297
folders. See files and folders
fonts, 91. See also CSS (Cascading Style Sheets); Flash; styles
    Change Property behavior for, 376
    changing text font, 104
    for headings, 84
    link font, setting, 83
    modifying families, 108
    nested font tags, combining, 473
preferences, setting, 109
    setting font properties, 82
    size, modifying, 105
special characters and, 96
table text, 191
    web, 106-107
formatting. See also tables
    characters, 104-105
Coding toolbar options, 343
    copying/pasting, setting for, 102
CSS (Cascading Style Sheets) code preferences, setting, 238-239
images, 148
    multiple changes, making, 105
    paragraph text, 103
    with Paste Special, 100-101
forms, 309
    aligning image buttons, 321
    buttons, 314
        image buttons, inserting, 321
        objects, inserting, 314
        working with, 320
checkboxes
    inserting, 315
    modifying, 318
creating forms, 312-313
CSS rules
    for buttons, 320
    for image buttons, 321
    for lists/menus, 319
forms, CSS rules (continued)
  for radio buttons/checkboxes, 318
  for text fields/text areas, 317
dynamic elements, 310
creating, 322
elements, 310
dynamic form elements, 310, 322
element code for, 328
example code for, 328
example code of, 310-311
GET method, 313
image buttons, inserting, 321
Input Tag Accessibility Attributes dialog box options, 315
inserting form objects, 314-315
jump menus, 326-327
labels
  for buttons, 320
  for objects, 315
layout for, 313
lists/menus
  inserting, 315
  jump menus, 326-327
  working with, 319
naming, 313
password files, creating, 317
POST method, 313
radio buttons
  inserting, 315
  modifying, 318
showing/hiding
delimiters, 89
fields, 88
tables for controlling, 323
text fields/text areas
  inserting, 314
  modifying, 316-317
  type designations for, 317
Validate Form action, 358
validating, 310
  example code for, 328
  HTML form data, validating, 324-325
  Validate Form action, 358
frames and framesets, 273
accessibility values, editing, 282
adding
gamma of image, adjusting, 133
Garamond font, 91
general fonts, 108
general preferences, setting, 60-61
GET method for forms, 313
GIF files, 29
  images, 132
  inserting, 136-137
  optimizing for, 148-149
  tracing images in, 86, 202
  transparent GIFs, 258
goals of site, 2
Go To URL behavior, 358
  working with, 370
graphics. See images
grids and guides. See also rulers
  frame document, laying out, 274
  working with, 56-57
grouping/ungrouping panels, 49
grow/shrink, 368
  spry effect, adding, 404
guides. See grids and guides
GUI (graphic user interface), 16
GW Micro, Window-Eyes, 476

Hand tool, 52
headers and footers, snippets for, 408
headings
  frame headings, changing, 284
  page properties, setting, 84
head tags, working with, 340
height. See also Flash; tables
  for ActiveX objects, 303
  of AP elements, 247, 249
  of horizontal rules, 111
  image height, changing, 150, 152
  for Java applets, 301
help, 38-39
hexadecimal codes, 105
hiding. See showing/hiding
hierarchical storyboards, 7
highlighting, 368
  library item highlight color, 66, 428
  preferences, setting, 66
spry effects, adding, 404
History panel, 535. See also commands
  clearing, 536
  closing, 536
  copying steps between documents, 539
  defining History steps, 545
  description of, 536
  managing commands, 543
  number of steps, changing, 61, 129, 545
  opening, 536
  replaying steps from, 538
  running History commands, 542
  saving steps as commands, 540-541
  undoing/redoing, 129
    multiple History steps, 537
    Undo/Redo slider, 536
  workarounds for steps not recorded, 541
home page
  setting page as, 80
horizontal rules
  inserting, 111
  modifying, 111
Host Directory for FTP, 488
hotspots. See image maps
HSB sliders, 65
HTML (Hypertext Markup Language), 29, 67, 329. See also Code view; Code View Live; events; forms; frames and framesets; HTML5, named anchors; Quick Tag Editor; spry widgets; Tag inspector
  balanced code, checking for, 470-471
  Browser Compatibility Check (BCC), 466-467
  browser-safe scripts, inserting, 355
  cleaning up, 472-473
    Microsoft Word HTML, 474-475
comments
  deleting, 343
  inserting, 341
  with Copy and Paste Special, 101
  copying/pasting, setting for, 102
CSS (Cascading Style Sheets)
  compared, 206
  description of, 330-331
  explanation of, 330-331
  file formats, 79
  head tags, working with, 340
**HTML (continued)**

- opening Web pages with, 28
- properties, changing, 81
- reports on attributes, 478
- search engines, 331
- selecting, 61
- shortcuts as HTML, exporting, 59
- spry HTML data set, displaying, 396-397
- syntax of code, 344
- Tag Chooser, using, 347

**HTML5**

- code hints, using, 339
- creating new
  - blank, 21, 520-521
  - sample, jQuery mobile, 25, 520-521
  - template, 22
- embedding video or audio, 299
- packaging for mobile app, 532-533
- HTTP address for site, 487
- HTTP links, 162
  - adding, 166-167
- hue, 64-65
- hybrid CSS layout, 208

**icons, Design Notes**, 498

**IDs. See also CSS (Cascading Style Sheets)**

- for form objects, 315
- Illustrator, 2, 58

**image buttons in forms**, 321

**image maps**

- creating client-side image map, 172
- modifying hotspots, 174
- server-side image maps, 172
- showing/hiding, 88

**Image Optimization dialog box**, 143

**images, 131. See also Adobe Bridge; backgrounds; Fireworks; frames and framesets; Photoshop; preloading images; rollover images; tables**

- aligning, 150
- assets, displaying, 417
- brightness, changing, 154
- contrast, changing, 154
- cropping, 153
- default images folder, 487
- download size, displaying, 53

**external editors, 145**

- file type, setting, 146-147
- file type preferences, setting, 146-147
- Fireworks images, inserting, 142-143
- folder, defining, 134-135
- formats, 132-133
- inserting, 136-137
- low source images, 151
- optimizing, 151, 148-149
- placeholder, inserting, 158-159
- previewing, 148-149
- Properties panel
  - modifying with, 150
  - resizing, 152
- rollover images, creating, 158-157
- sharpness, changing, 155
- Swap Image behavior, 358, 374-375
- Swap Image Restore behavior, 358, 374-375
- tracing image, inserting, 86
- URL to image, applying, 421
- Web-friendly graphics, 132-133

**<i> tag**, 117

**<img> tag**, 152

**importing/exporting**

- Microsoft document data, 94-95
- shortcuts as HTML, exporting, 59
- tabular data, importing, 93
- table data, 192-193
- templates, XML data to, 457-458

**Inconsistent Region Names dialog box**, 451

**InContext Editing**

- adding CSS formatting, 449
- creating editable region, 448-449
- creating repeating region, 446-447
- deleting, 447

**indenting**

- code, 353
- CSS source code options, 238
- for HTML code, 337
- for lists, 112
- paragraph text, 103

**InDesign. See Adobe Bridge**

**index.htm**, 80

**Info bar**, 229, 349

- syntax error alert, in Info bar, 337, 343

**information-gathering**, 9
inheritance, 232
Input Tag Accessibility Attributes dialog box, 315
Insert HTML mode, Quick Tag Editor in, 345
Insert panel or Insert bar, 44, 46, 48
objects, prompt on inserting, 60
Inspect, 229
Inspiration Web site, 4
installing
Dreamweaver, 13
Intel-based Macintosh systems, 11
Internet. See browsers; remote site; Web pages; Web sites
Internet Explorer, 36
ActiveX controls in, 302
events, support for, 359, 360
Web-safe colors, 64
invalid code, Coding toolbar options, 343
invisible elements, 87
selecting, 90
working with, 88-89
invisible maps, 87
iOS-based devices (iPhone, iPod Touch, and iPad)
packaging for, 518-519, 532-533
iPhone, iPod Touch, or iPad. See iOS-based devices
IPA file format, 532-533
IPK file format, 532-533
IPv6 transfer mode, 489
ISP (Internet service provider), 500
italicizing
characters in text, 104
with Copy and Paste Special, 101
copying/pasting, setting for, 102
for headings, 84
for links, 83
table text, 191

J
JAD file format, 532-533
Jakarta Tomcat server, 68, 382
Japanese characters, enabling inline input for, 61
Java applets, 291
inserting, 300
preferences, modifying, 301
Java files, 79
JavaScript. See also AP elements; behaviors; external JavaScript libraries; spry widgets
attaching behaviors to links, 175
Call JavaScript behavior, 381
executing, 381
files, 79
null/script links, creating, 175
rollover image name, 156, 157
showing/hiding, 88
Java Server pages, 79
JAWS for Windows, 476
Joomla, 351
JPEG/JPG files, 29
images, 132-133
inserting, 136-137
optimizing for, 148-149
tracing images in, 86, 202
jQuery Mobile
code hints, using, 339
inserting components, 522-523
introduction, 518-519
Mobile App
changing orientation, 530
creating, 520-521
packaging for Android, Apple iOS, Blackberry, Symbian, or WebOS, 532-533
previewing, 528-529
saving, 531
Mobile Starter, 25, 520-521
Packaging with PhoneGap, 518-519, 532-533
swatches, 524-525
ThemeRoller, 524-525
themes, 524-525
using, 518-519
JRun custom library tags, inserting, 347
JSP files tags, inserting, 347
jump menus, 175, 326-327
editing, 327
text in, 326
justifying paragraph text, 103

K
keyboard shortcuts. See shortcuts
keywords, 4
tags, 340

L
labels. See forms
languages for spell-checking, 127
Lasso files, 79
last saved version of document, reverting to, 27
launching Dreamweaver, 14-15
Launch phase, 8
layers. See AP elements
layouts for Fluid Grids
creating, 23, 262-263
deleting elements, 267
inserting elements, 267
introduction 261-262
moving layouts, 270
preview in a browser, 271
resizing layouts and margins, 268-269
selecting elements, 266
showing/ hiding guides, 265
viewing, 264
layouts for forms, 313
Layout table mode. See tables
left alignment of paragraph text, 103
libraries. See also external JavaScript libraries; library items; tag libraries
disconnecting library item from, 425 files, 79
introduction to, 407, 416
library items, 416. See also external JavaScript libraries
creating, 424
deleting, 429
disconnecting item from library, 425
editing, 426-427
filename and location, displaying, 427
highlighting color preferences, setting, 66, 428
list, displaying, 417
planning for, 416
recreating missing or deleted items, 429
renaming, 429
updating on page or site, 428
using, 425
linear storyboards, 7
line breaks
for code, 353
controlling, 110
with Copy and Paste Special, 101
copying/pasting, setting for, 102
showing/hiding, 88
line numbers
Coding toolbar options, 342
for HTML code, 337
line spacing. See spacing
links, 161. See also email links; Flash; paths automatically updating, 178
broken links, finding and fixing, 460-462
cache files, creating, 178-179
case-sensitive links, checking, 487
deleting, 177
frame links, changing, 284
for image placeholders, 158-159
menu links, adding, 393
to Microsoft documents, 95
modifying, 176
named anchor, adding, 170-171
null links, creating, 175
opening linked pages, 180-181
orphan links, 182, 461
properties, setting, 83
relative path for new links, setting, 164-165
relative to documents, 487
script links, creating, 175
sitewide changes to, 182, 462-463
to sound files, 298
targeted links, creating, 288-289
testing, 180-181, 460-462
text links, adding, 166-167
types of, 162
updating, 178-179
when moving files, 60
link tag, 340
liquid CSS layout, 208
List Properties dialog box, 115
lists. See also definition lists; forms; ordered/unordered lists
CSS styles, changing settings for, 253
modifying, 115
Live Code View, 336
color preferences, 356
LiveDocs database, 39
Live View, 32-33
inspect, 229
Multiscreen Preview panel, 34-35, 528-529
testing link, 180-181
local files, 506-507
Local Info, 484
defining, 486-487
Local/Network options, 489-490
local root folder, 67, 486
creating, 11, 19
elements of site in, 18
for relative path for new links, 164
setting up, 69
working with, 68
Locate in Site command, 76-77
locked regions, color preferences for, 66
Lock Guides, clearing, 57
logical styles, 116
login for WebDAV server, 490
logos, snippets for, 408
Long Description input box, 137
long descriptions, using, 477
looping, Flash/Shockwave movies, 295
low source images, 151
luminosity, 64-65

M
Macintosh systems, 11
browsers on, 36
case sensitivity of file names, 27
color palette, 64
launching Dreamweaver in, 14-15
requirements for, 12
macros. See snippets
magnification, setting, 52
mailto links, 162
Manage Sites dialog box, 20
managing sites. See also remote site advanced site definitions, setting, 484-485
maps. See also image maps; site maps
mind maps, creating, 4-5
margins
frame margins, changing, 285
setting page margins, 82
marketing plans, creating, 479
maximizing. See minimizing/maximizing
media queries
creating, 526-527
Multiscreen Preview panel, 34-35, 528-529
setting default location, 486-487
using, 526-527
menus or menu bars, 17. See also forms spry menu bar widgets, using, 392-393
merged cells. See tables
message for Flash video, 297
meta tags, 340
Microsoft Excel
importing content from, 94
links to document, creating, 95
Microsoft Internet Information Server (IIS), 68, 382, 434
Microsoft Word
cleaning up HTML, 474-475
importing content from, 94
links to document, creating, 95
working with, 101
MIDI files, linking or embedding, 298
MindGenius Web site, 4
mind maps, creating, 4-5
Mindmap Web site, 4
Mind tools Web site, 4
minimizing/maximizing, 17. See also
zooming; Zoom tool panels, 45
Mobile App. See jQuery Mobile
Mobile Starters, 25, 520-521. See also
jQuery Mobile
monitors, rulers with, 55
Mouse-Over region colors, 66
MOV files, linking or embedding, 298
movies. See also Flash; QuickTime; Shockwave
assets, displaying, 417
moving
AP elements, 255
Coding toolbar options, 343
CSS rules, 226-227
Files panel, files or folders in, 75
MPEG files, linking or embedding, 298
MP3 files, linking or embedding, 298
Multiclass selection, 216-217
multimedia. See Flash; Shockwave
Multiscreen Preview panel, 34-35
media queries, 34-35, 526-529
multiple documents, viewing, 31
MySQL, 339, 382, 492

N
named anchors
adding, 170-171
links, adding, 171
showing/hiding, 88
naming/renaming. See also Flash
ActiveX objects, names for, 303
AP elements, 250
case sensitivity of file names, 27
class names, 207
columns in site, 495
commands, 543
naming/renaming
CSS selector declaration, 225
favorite assets, creating nickname for, 423
forms, 313
Java applets, names for, 301
library items, 429
Local Info, site name in, 486
local root folder, 68
panel sets, 50-51
pasting, renaming form items when, 354
rollover images, 156
shortcut sets, 58
snippets or snippet folders, 414
styles, renaming, 120
templates, 439
Web pages, 26
workspaces, 50-51
nesting. See also tags; templates
AP elements, 246
lists, 112
tables, 204
Netfirms Web site, 3
Netscape Navigator. See also plug-ins
AP element compatibility, setting, 247
events, support for, 359, 360
Web-safe colors, 64
New Document dialog box
sample file designs in, 25
selecting to show, 63
template designs, selecting, 24
New Library Item button, 424
news links, 162
new Web site, creating, 18-19
nicknames for favorites assets, 423
noframe element, 277
information for browser with no frame support, 277
Non-Breaking Space command, 96
null links, creating, 175
numbered lists. See ordered/unordered lists

O
objective of site, 3
OLE controls, 302
onBlur event, 359
onClick event, 359
onDoubleClick event, 359
onError event, 359
onFocus event, 359
onKeyDown event, 359
onKeyPress event, 359
onKeyUp event, 359
onLoad event, 359
onMouseDown event, 359
onMouseMove event, 359
onMouseOut event, 359
onMouseOver event, 156, 358-359
onMouseUp event, 359
Open Browser behavior, 175
working with, 371
Open dialog box for templates, 439
opening
documents with tabs, 60
Files panel, files in, 72
linked pages, 180-181
panels, 46
predefined sites, 20
Related Files toolbar, 348-349
opening tags, 330
optimizing images, 148-149, 151
ordered/unordered lists
creating, 112-113
CSS properties, setting, 223
  modifying, 115
  paragraph text, converting, 103
  text, creating lists with, 113
O'Reilly reference manuals, 332
orphan links, 182, 461
outdenting Coding toolbar options, 343
overlapping of AP elements, preventing, 254
Override Case of option, 353

P
  packaging
    for Android, Apple iOS, Blackberry, Symbian, or WebOS, 532-533
  page breaks, setting, 223
  page positions, setting, 223
Page Properties dialog box, 69, 81
  Appearance category, 82
  Headings category, 84
  Links category, 83
  Title/Encoding category, 85
panel gripper, 46
Panel Options menu, 46-47
panels, 43, 16. See also Files panel; History panel
docking/undocking, 48
  expanding/collapsing, 46-47
  grouping/ungrouping, 49
header bars, 17
information area, expanding and collapsing, 47
opening/closing, 46
  showing/hiding, 51
panel sets, 50-51
paragraphs. See also styles
  formatting text in, 103
  line spacing, controlling, 110
  plain paragraph after reading, switching to, 61
parameters
  for ActiveX objects, 303
  for Flash/Shockwave movies, 295
  for Java applets, 301
parentheses balance, checking for, 470-471
passive FTP, 489
passwords
  forms, creating field for, 317
  for FTP access, 488-489
  for WebDAV server, 490
Paste Special command, 100-101
pasting. See copying/pasting
paths, 163
  relative path for new links, setting, 164-165
Pewinternet Web site, 3
PhoneGap Build Service, 518-519, 532-533
PhoneGap. See jQuery Mobile
Photoshop, 2. See also Adobe Bridge
  copying/pasting images, 139-140
  editing images in, 140-141
  inserting images from, 138-139
  shortcuts, 58
  Smart Objects, 138-141
  tracing images in, 202
PHP files, 29, 79
  tags, inserting, 347
physical tags, 116
placeholders for images, inserting, 158-159
planning, 1-3
  mind maps, creating, 4-5
  for search engine submission, 20
plug-ins. See also Check Plug-in behavior; QuickTime
checking for, 306-307
inserting content, 304
playing, 305
troubleshooting, 305
PNG files
  images, 133
  inserting, 136-137
  optimizing for, 148-149
  tracing images, 86, 202
Point/Pica size, choosing, 55
PointTo File icon, 171
Popup Message behavior, 358
  working with, 372-373
positioning form objects, 315
POST method for forms, 313
Postscript Point/Pica size, 55
predefined sites, opening, 20
preferences. See also Code view; CSS (Cascading Style Sheets)
accessibility preferences, setting, 476
AP element preferences, setting, 247
for copying/pasting, 102
font preferences, setting, 109
general preferences, setting, 60-61
highlighting color preferences, setting, 66
preferences (continued)
History panel preferences, setting, 545
Java applet preferences, modifying, 301
new document preferences, setting, 62-63
Preferences dialog box
AP Element section, 247
Code Coloring section, 356
Code Format section, 353
Code Hint section, 352
Copy/Paste section, 102
File Types/Editors section, 146-147
invisible elements, selecting, 88-89
links, updating, 178
preloading images, 358
rollover images, 157
working with, 374
Preview In Browser feature, 36
Fluid Grid Layouts, 271
testing, 468-469
previewing
assets, 418
Flash movie content, 295
images, 148-149
pages in Live view, 32-33
relative path for new links, 164-165
synchronized files, 515
Web pages, 36-37
Preview Using Temporary File option, 164
Primary Browser, 37
primary fonts, 108
printing code, 337
prioritysubmit Web site, 20
Program window, 17
Progressive Download Video, 296
properties. See also frames and framesets
adding, 377
AP element properties, modifying, 252-253
change Property behavior, 376-377
CSS properties, setting, 222-223
CSS properties, in Properties panel, 220-221
CSS-P (Cascading Style Sheets-Positioning) properties, modifying, 252
deleting, 377
editing, 377
Flash movie properties, changing, 294-295
for image placeholder, 158-159
Shockwave movie properties, changing, 294-295
table properties, changing, 198-199
Properties panel. See also images
Crop button, 153
format text characters, 104-105
modify images, 150-152
with spry validation widgets, 390-391
Property Inspector, 16-17
Flash movie controls, access to, 293
proportional fonts, preferences, 109
proportions of images, resizing, 152
pseudo-classes in CSS (Cascading Style Sheets), 233
queries
searches, creating and using, 550
media, creating and using, 526-527
quick frame links, creating, 290
Quick Response code, 532-533
QuickTag Editor
Code Hints with, 338-339
in Edit Tag mode, 345
in Insert HTML mode, 345
opening, 344
syntax of code, 344
in Wrap Tag mode, 345
QuickTime, 291
content, inserting, 304
linking or embedding MOV files, 298
quitting Dreamweaver, 42
radio buttons. See forms
RA files, linking or embedding, 298
RDS (Remote Data Services) options, 491
read-only file warnings, setting, 60
RealPlayer, 298
   content, inserting, 304
recently modified files, finding, 77
recently opened Web page, opening, 29
reference help, 39
Reference panel, 332-333
   specific information, accessing, 333
Refresh button, Files panel, 502
refreshing Files panel, 72
refresh tag, 340
regions. See templates
regular expressions
   for tag find and replace, 549
   for text find and replace, 547
Related Files toolbar, 348-349
   filtering, 215
   preferences, 348
relative positioning of AP elements, 248
Relevant CSS rules, viewing, 232
remote folders, 67
   setting up, 69
   working with, 68
Remote Info, 484
   defining, 488-491
remote site
   checking in and out site files, 508-509
   comparing local and remote files, 506-507
   file preferences, setting, 500-501
   Files panel, managing files with, 502-503
   transferring files to and from, 504-505
Remove Event button, 367
renaming. See naming/renaming
Rendering toolbar, 44
reopening documents on startup, 60
repeating background, setting, 82
replacing. See finding/replacing
replaying History panel steps, 538
reports
   accessibility reports, creating, 477
   saving, 480-481
   testing sites, running reports for, 478-479
   viewing, 480
Report Settings button, 478
resizing. See sizing/resizing
resizing table columns and rows, 195
Results panel, 124
rewinding Flash video, 297
RGB color mode, 64-65
Rich Internet Applications, 292
   help, 39
right alignment of paragraph text, 103
rollover images
   with AP elements, 256-257
   creating, 156-157
   customizing, 157
   link colors, 83
   preloading, 157
   showing/hiding, 256-257
root folders, creating, 10
rules, working with, 55
S
Safari, 36
samples
   creating Web page from, 25
   page sketches, 5
saturation, 64-65
Save As dialog box
   different formats, saving files in, 78
   file type, changing, 67
saving. See also templates
   finding/replacing query, 122
   framesets, 280-281
   last saved version, reverting to, 27
   reports, 480-481
   searches, 333
   Web pages, 26-27
scaling for Flash/Shockwave movies, 295
scripts. See also external JavaScript libraries
   assets, displaying, 417
   showing/hiding, 88
   snippets for, 408
scrolling display, changing, 285
SDK (Software Development Kit), 532-533
search engines, 20
   adding HTML for, 331
   Yahoo, Google, Bing, 20
searching. See finding/replacing
Secondary Browser, 37
secondary fonts, 108
secure FTP (SFTP), 488-489
Section 508, accessibility issue, 9
Select All command, 99
selection, Multiclass, CSS, 216-217
Selection submenu, 341
selector declaration. See CSS (Cascading Style Sheets)
Select tool, 52
servers. See also FTP (File Transfer Protocol); testing servers
technologies, 11
URI for Flash video, 296
Server behaviors, 382
server-side files, 79
showing/hiding, 89
server-side image maps, 172
Set Text behavior, 372
Set Text Of Status Bar behavior, 175
shading of horizontal rules, 111
shakes, 368
  spry effects, adding, 404
sharing
  columns in site, 495
  snippets, 413
sharpness of images, changing, 155
Shockwave
  assets, displaying, 417
  inserting movies, 293
  properties of movie, changing, 294-295
shortcuts, 3, 43
  creating shortcut set, 58
  deleting, 58-59
  guides, working with, 57
  HTML, exporting as, 59
  on Macintosh systems, 15
  for previewing pages, 37
  for snippets, 411
shorthand CSS preferences, setting, 240
Show/Hide Elements behavior, 358
  working with, 380
showing/hiding. See also forms
  AP element borders, 246
  columns in site, 495
  CSS style sheets, 241
  HTML code, hidden characters for, 337
  library item highlighting, 428
panels, 51
rollovers, 256-257
table column widths, 188
toolbars, 44
visual aids, 87
single-clicking on text, 98
site definition
  advanced, 484-485
  basic, 18-19
cloaking site, 494
importing site, 20
local info, 486-487
remote info, 488-491
opening site, 20
testing server, 492-493
version control, 493
Site Files View, 70
site specific code hints, 351
site reports. See reports
site root
  option, 164
  relative paths, 163
sitewide link changes, making, 182, 462-463
sizing/resizing. See also Flash; frames and framesets
  AP elements, 255
  Assets panel, 422
document size, displaying, 52
Flash/Shockwave movies, 294
font sizes, changing, 105
image map hotspots, 174
images, 152
Point/Pica size, choosing, 55
Split view, panes in, 334
Status bar, setting window size from, 53
of table text, 191
sketches of sample page, 5
skin for Flash video, 296
slides, 369
  spry effects, adding, 404
Smart Objects, Photoshop, 138-141
Snap to Grid/Snap to Guide, 56
snippets
  block snippets, 409
    creating, 415
    editing, 413
  creating, 415
deleting, 413
downloading, 409
editing, 412-413
example of, 408
folder for snippets, creating, 414
inserting, 410
introduction to, 407-409
keyboard shortcuts for, 411
recent snippet, inserting, 411
renaming, 414
sharing, 413
wrap snippets, 409
  adding, 411
  creating, 415
  editing, 413
Snippets panel, 407
sorting assets, 422
sorting table data, 197
sounds
  files, linking or embedding, 298-299
spacings. See tables
spacing
  characters, spaces between, 96
  controlling line spacing, 110
  with Copy and Paste Special, 101
copying/pasting, setting for, 102
CSS properties, setting, 222, 238
multiple consecutive spaces, allowing, 61
spam blockers, 166
special characters. See characters
Specificity, 232
speed
  file transfer speed, 482
  of site, 459
spelling, 126-127
dictionaries for, 61
languages for, 127
splash screens, 293
split cells. See tables
Split view, 30, 31, 334
  Coding toolbar, 342-343
  resizing panes in, 334
  visual aids in, 87
Split Code view, 30, 31
SpryAssets folder, 384
  defaults, changing, 385
Spry framework help, 39
spry regions
  creating, 400-401
  repeat list, creating, 402
  repeat regions, creating, 400-401
spry tabbed panels, 388
spry widgets
  accordion panels, 388
  advanced site definitions for, 485
  appearance, changing, 387
  collapsible panels, 388
  customizing, 403
data sets, HTML or XML, 406-399
  editing, 386
effects, adding and removing, 404-405
inserting, 384-385
introduction to, 383
menu bar widgets, 392-393
regions, creating, 400-401
repeating list, 402
selecting, 386
tables, creating, 397, 399
tooltip, 394-395
validation widgets, 390-391
working with, 388-389
XML data set, identifying, 398
squishes, 369
spry effects, adding, 404
stacking order. See AP elements
Standard table mode. See tables
Standard toolbar, 44
Start menu, 29
startup, reopening documents on, 60
static pages, 69
statistics of download, gathering, 482
Status bar, 17. See also text
  connection speed, setting, 53
  Set Text Of Status Bar behavior, 175
  using, 52
    window size, setting, 53
STE (Site Definition File) file format, 20
storyboards, creating, 7
streaming Flash video, 296-297
<strong> tag, 61, 117
Structure phase, 8
Style popup, 120
styles. See also CSS (Cascading Style Sheets); CSS-P (Cascading Style Sheets-Positioning)
  built-in text style, applying, 116-117
  for characters, 104
  CSS text style, creating and applying, 118-119
  for form objects, 315
  logical styles, 116
styles (continued)
  renaming styles, 120
  size and font style, applying, 117
  for table text, 191
  turning off/on, 393
Style toolbar, 44
submission of site, 20
Submit Express web site, 20
Subversion
  enabling, 493
  using, 510-511
Swap Image Restore behavior, 358
  working with, 374-375
Swap Images behavior, 358
  working with, 374-375
swatches, jQuery Mobile, 524-525
SWF format, 292
switching
  between table modes, 185
  between Web pages, 31
Symbian
  packaging for, 518-519, 532-533
Symbols font, 96
synchronizing
  comparing files while, 507
  displaying information on, 515
  Local/Network options, 489-490
  for RDS, 491
  site files, 514-515
  for WebDAV server, 490
syntax coloring for HTML code, 337
syntax error alerts in Info Bar, 343
system requirements, 12

T
  tab index
    for form objects, 315
    for links, 167
  tables, 183
    adding columns or rows, 194
    alignment, 199
      captions, aligning, 187
      Layout mode, changing in, 199
      of nested tables, 204
      of text, 191
      of tracing images, 203
  AP elements to tables, converting, 258-259
  backgrounds
    cell backgrounds, formatting, 201
    setting, 199
  borders, 87, 199
    cell border colors, 201
  captions, entering, 187
  cell padding
    formatting, 198
    values, 187
  cell spacing
    formatting, 198
    values, 187
  classes, 199
  colors, 199
    of text, 191
  content to table, adding, 190-191
  deleting
    columns and rows, 194
    empty layout cells, 187
  Expanded mode for, 185
  exporting table data, 192-193
  formatting, 198-199
    cells, 200-201
    text, 191
  forms, controlling, 323
  header positions, 187
  heights
    clearing, 199
    modifying, 189
  images
    adding, 190
    cells, formatting for, 201
    tracing images, 202-203
  importing table data, 192-193
  merged cells, 196
    formatting, 201
  nested table, creating, 204
tables (continued)
  pixels, converting widths and heights to, 199
  placement of cells, modifying, 200
  properties of table, changing, 198-199
  repeating tables, creating, 443
  resizing columns and rows, 195
  showing/hiding column widths, 188
  sorting table data, 197
  split cells, 196
    formatting, 201
  spry tables, creating, 397, 399
  Standard mode, 185
    inserting table in, 186-187
    nesting table in, 204
    properties, changing, 198
  summary, creating, 187
  switching between modes, 185
  Table ID, entering, 198
  text
    adding, 190-191
    importing tabular data as, 93
    wrapping text options, 201
  tracing images, using, 202-203
  widths
    clearing, 199
    fixed width, setting column to, 188
    modifying, 189
    working with, 184
  tab size for code, 353
  Tag Accessibility Attributes dialog box, 390-391
    alternate text, using, 477
  Tag Chooser, 347
  Tag Inspector, using, 346
  tag libraries, 347
  descriptor files, 79
tags. See also CSS (Cascading Style Sheets); HTML (Hypertext Markup Language); Quick Tag Editor; tag libraries
  advanced find and replace for, 548-549
  balanced tags, checking for, 470
  combining nested font tags, 473
  finding/replacing
    advanced find and replace, 548-549
  code, tags in, 333
  saving tag searches, 333
  nested tags
    combining nested font tags, 473
    fixing, 354
    redundant nested tags, 479
    reports testing, 478-479
  physical tags, 116
  selecting, 90
  third-party tags color preferences, 66
  Tag selector, 52, 99, 342
  target audience. See audience
targets, 393. See also Flash
  links, targeted, 288-289
  TD tags, 353
telnet links, 162
templates. See also Assets panel
  advanced site definitions for, 485
  all pages, updating, 454
  attachments
    detaching templates, 456
    opening attached templates, 439
    working with attached templates, 456
  blank template, creating, 22
  creating, 437
  custom templates, creating Web page from, 453
  deleting, 439
    editable regions, 440
    repeating region entries, 442
  detaching templates, 456
downloading, 436
  editable attributes, defining, 441
  editable regions, 436
    creating, 23, 446-449
    defining, 440
    finding, 455
    highlighting color preferences, setting, 66
    nested editable regions, colors for, 66
    optional regions, creating, 444-445
  existing template, creating Web page from, 24
  exporting template data as XML, 457-458
  file formats, 79
  finding editable regions, 455
  Flash template files, 292
templates (continued)
importing XML data, 457
inconsistent region names, 451
InContext Editing
  adding CSS formatting, 449
  creating editable region, 448-449
  creating repeating region, 446-447
  deleting, 447
introduction to, 435-436
list of templates, displaying, 417
manually updating pages based on, 455
nested templates
  creating, 450-451
  highlighting color preferences, 66
  Web page from, 452
non-editable optional regions,
  creating, 444
Open dialog box, opening with, 439
opening, 438-439
optional regions, creating, 444-445
relocking editable regions, 440
renaming, 439
repeating regions, creating, 400-401,
  442-443
repeating tables, creating, 443
saving, 437
  Web pages as templates, 27
storing templates, 23
time-saving tips for, 455
updating, 454-455
XML data, importing and
  exporting, 457-458
testing. See also accessibility; validation
  broken links, finding and fixing, 460-462
  browser compatibility, 361, 466
  checking pages in a browser, 468
  introduction to, 459
  links, 180-181, 460-462
  reports testing site, 478-479
servers, 484
  technical, 463
  usability, 467
  using Adobe BrowserLabs, 468-469
testing servers, 67, 484
defining, 492
setting up, 69
working with, 68
text, 91. See also characters; copying/pasting; finding/replacing; Flash; fonts; styles; tables
  adding text to page, 92
  advanced text find/replace, 546-547
colors
  applying, 421
  changing, 105
dynamic text, 89
  for image placeholders, 158-159
  in jump menus, 326
  links, adding, 166-167
  lists with existing text, creating, 113
Open Browser behavior with, 371
paragraph text, formatting, 103
Paste Special for, 100-101
for rollover images, 157
selecting, 98-99
selection, finding text by, 121
Set Text behavior, 372
setting properties, 82
Status bar
  displaying text with, 372-373
  selecting with, 99
URL to text, applying, 421
text fields/text areas. See also forms
displaying text in, 372
  spry validation widgets, 390
text files, 79
text messages, displaying, 372-373
Thawte, 488-489
themes, 4
  sample pages with, 25
  jQuery Mobile, 524-525
  ThemeRoller, 524-525
third-party file comparison tool, 506-507
tiling Document window, 41
times, adding, 97
Times New Roman font, 91
titles
  frameset page title, setting, 287
  for text links, 167
  Web page titles, changing, 85
toolbars, 43, 17
  Coding toolbar, 342-343
  showing/hiding, 44
  working with, 44
toolips, adding, 393
spry tooltip, 394-395

tracing images, 86
frame tracing image, changing, 284
in tables, 202-203

Traditional Point/Pica size, 55

transitions, CSS
creating, 230-231
editing, 230-231
removing, 230-231

transparency for images, 149
transparent GIFs, 258
triple-clicking on text, 98
troubleshooting plug-ins, 305

U
underline style popups, 83
undoing/redoing, 128-129. See also History panel
Undo/Redo slider, History panel, 536
Unicode normalization form, selecting, 63, 85
Unicode signature (BOM), selecting, 63
untitled documents, list of, 479
Update Current Page method, 428
Update Pages command, 428

updating. See also links
Fireworks images, 143
library items, 428
Photoshop images, 140-141
templates, 454-455
Web updates, obtaining, 40

URL assets
displaying, 417
image, applying URL to, 421
new URL asset, adding, 420
text, applying URL to, 421

URLs (Uniform Resource Locators). See also Flash; Go To URL behavior; links
absolute paths and, 163
in jump menus, 327
opening Web page with, 28
rollover images linked to, 157
for WebDAV server, 490
usability testing, 467
UseableNet Accessibility Reference, 332

Use Dynamic Font Mapping check box, 109

V validation, 464-465. See also forms
preferences, setting, 464
spry validation widgets, 390
Web pages, validating, 464-465
World Wide Web Consortium (W3C) standards, 465
Validator, 464-465
VBScript files, 79
showing/hiding, 88
VeriSign, 488-489
version control
Subversion, enabling, 493
views and viewing
Browser Compatibility Check (BCC) report, 237
Design Notes, 498
download statistics, 482
Dreamweaver window, viewing, 16
Files panel, viewing files in, 70
multiple documents, viewing, 31
reports, 480
switching between views, 31
Tag Inspector views, 346
working with views, 30
Zoom tool, changing view with, 54

visibility of AP elements, 247
visitor link colors, 83
visual aids, using, 87
visually impaired persons, alternate text for, 477
visual server markup tags, showing and hiding, 89
VTML files, 79

W warnings
read-only file warnings, 60
tags, fixing or removing, 354
WAV files, linking or embedding, 298
W3C Validation. See validation
Web Content Accessibility Guidelines (WCAG),
introduction, 9
web site, 9
WebDAV options, 490
web fonts, 106-107
   site definition, 484-485
WebKit
   live view, 32-33
WebOS
   packaging for, 518-519, 532-533
web pages. See also home page;
   templates; testing
   blank page, creating, 21
   closing, 41
   custom template, creating from, 453
   dynamic pages, 69
   existing page, opening, 28
   naming, 26
   nested templates, creating from, 452
   previewing, 36-37
   properties, setting, 81
   recently opened page, opening, 29
   sample, creating from, 25
   saving, 26-27
   static pages, 69
   switching between, 31
   validating, 465
web-safe colors, 64
web server, 68, 382
web sites. See also testing; Web pages
   for snippets, 409
   for templates, 436
   welcome screen, showing, 60
WGZ file format, 532-533
wheel storyboards, 7
whitespace
   for ActiveX objects, 303
   finding/replacing ignoring, 123
   Flash/Shockwave movies, setting for, 295
   for Java applets, 301
   for tag find and replace, 549
   for text find and replace, 547
whole word match
   for tag find and replace, 549
   for text find and replace, 547
widgets. See spry widgets
widths. See also tables
   for ActiveX objects, 303
   of AP elements, 247, 249
Flash video settings, 296
   of horizontal rules, 111
   image width, changing, 150, 152
   for Java applets, 301
Window-Eyes, 476
Windows Media Player, 298
Window Sizes
   Multiscreen Preview, 34-35
   preferences, 52-53, 482
Windows systems, 11
   browsers on, 36
   case sensitivity of file names, 27
   color palette, 64
   launching Dreamweaver in, 14-15
   requirements for, 12
wireframes, 5
WML files, 79
   tags, inserting, 347
Wordpress, 351
word wrap
   for form text, 316
   for HTML code, 337
workflows, 478
workspace. See panel sets.
World Wide Web Consortium (W3C), 132
   introduction, 9
   validation standards, 464-465
Web site, 9
wpromote Web site, 20
wrapping code, 353
wrap snippets. See snippets
Wrap Tag mode, Quick Tag Editor in, 345
WYSIWYG view, 30

X

XHTML (Extensible Hypertext Markup Language)
   cleaning up, 472-473
   definitions, selecting, 62
XML (Extensible Markup Language), 29
   file format, 79
   spry XML data set, displaying, 398
   templates, importing and exporting XML data into, 457-458
XSL format, 29
Y
Yahoo submission options, 20

Z
z-index to AP element, applying, 251
Zoom tool, 52
  changing view with, 54